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Hello agai n!
 The fi rst part of this article may seem 
familiar, but I wanted to repeat it as it is still rel-
evant.  

When you renew your membership…
 If it’s about time to renew your member-
ship, or if you want to join, you will receive an 
8GB USB fl ash drive as part of your membership.  
This is more than a DVD can hold!  

Elections…
 At the February 9 meeting, we will hold 
elections for members of the Board of Direc-
tors.  We would like to have new people step up 
and help out.  Presently Mike Regimenti holds 3 
offi ces, and Kris Johnson holds 2 offi ces.  If you 
would please consider running for one of these 
positions, the help will be GREATLY appreciated 
(and it’s very rewarding too).

New clothes…
 You will notice at the upcoming meetings 
that the BoD members and the usual volunteers 
at the CRSIG workshop will be sporting a new 
ChPCUG polo shirt.  This is in recognition of the 
hard work and dedication of these members.  If 
you would like to purchase one of these shirts, we 
will have some extras.

Spring Windows 7 course
 Sam Shepherd has volunteered to facilitate 
the Windows 7 course for this spring.  He is look-

ing for a volunteer or two to help in actually teach-
ing the course.  If you would like to learn more 
about Windows 7, this is a great way to learn, 
TEACH IT!  Please contact Sam if you have inter-
est.
 
February 9th Meeting – System Compo-
nents: Hard drive storage
This is a continuing series of meeting topics on the 
various parts of a PC.  It started in December with 
CPUs.  This time we will discuss the hard drive.  
A lot of people are not sure what is in there and 
this month, we will go in-depth to discuss where 
we have been, where we are, and where we are go-
ing with storage.

As for Windows 7 Service Pack 1; as of this 
writing it is still not released.  There is an article 
included in this issue of the newsletter discussing 
what is included for future reference.

March 9th Meeting – Streaming video to your 
devices (Netfl ix and similar)
That Blu-Ray player that you own is probably the 
last optical drive you will buy.  Most video content 
from the point forward will probably be stream-
ing from the Internet.  In March, this topic will be 
discussed and hopefully demonstrated.

April 13th Meeting – Backup solutions
A follow on to the system components will be the 
use of backup solutions for your data.  We will 
discuss external storage and off-site solutions.

I hope to see you at the upcoming meetings!

Michael



President
Mike Young........................................(410) 551-4411

president@chesapeakepcusersgroup.org
Vice President

Mike Regimenti.................................(301) 509-6091
vice-president@chesapeakepcusersgroup.org

Co-Treasurers
Kathy Walker (410) 266-6317    Bill Somers (410) 647-9429 
treasurer@chesapeakepcusersgroup.org

Secretary
Kris Johnson.....................................(410) 544-8706

secretary@chesapeakepcusersgroup.org
Publisher/Editor

Mike Regimenti.................................(301) 509-6091
                      editor@chesapeakepcusersgroup.org

CHAIRPERSONS
Programs Chairperson

Craig Barlow.....................................(410) 266-6829
programs@chesapeakepcusersgroup.org

Education Chairperson
Sam Shepherd...................................(410) 647-6077

education@chesapeakepcusersgroup.org
Membership Chairpersons

Margaret Duggan.............................(410) 647-2722
membership@chesapeakepcusersgroup.org

Public Relations Chairperson
Kris Johnson.....................................(410) 544-8706

pr@chesapeakepcusersgroup.org

SPECIAL INTEREST GROUPS (SIGS)
New Users Group

Sam Shepherd...................................(410) 647-6077
MidShore Computer Users Group SIG

George Ireland ................................ (410) 745-2361
mscug@chesapeakepcusersgroup.org

Technology SIG
Mike Regimenti.................................(301) 509-6091

internet@chesapeakepcusersgroup.org
Computer Refurbishing SIG

Fran Damratowski............................(410) 544-7047
refurbishing@chesapeakepcusersgroup.org

Webmeister
Mike DeLucia....................................(410) 721-2991 

webmeister@chesapeakepcusersgroup.org2

   cont’d from page 4

www.chpcug.org/               ChPCUG dues are $40 per year                THE PRINTER                 February        2011  

OFFICERS
the computer are offers for free screen savers, 
toolbars, utilities to play specifi c video formats 
(often attached to an email), sham online security 
scanners, contaminated PDF fi les, insecure web 
browsers, and other vectors.  The common thread 
of this rogue software is an authentic looking  
popup that informs the user that his computer is 
(falsely) infected with hundreds of viruses and 
Trojans, and for a fee it will clean the computer.  
These popups which will not permanently close 
will typically hijack the computer, destroy the 
installed legitimate security software, prevent 
access to online services that can kill it, prevent 
cleaning utilities from executing, and otherwise 
take control of the computer until the user pays 
a fee, typically $30 to $70.  This fee is to be 
paid by credit card or other online payment 
service to a website that looks legitimate, but is 
really a complete scam.  Not just will the rogue 
software not clean the computer of the pseudo 
infections after the fee is paid, but now a cyber 
criminal, often in Russia, has the user’s credit 
card information.  it is not uncommon for that 
same credit card information to promptly be 
sold on illicit websites, and to have substantial 
unauthorized charges appear on the compromised 
credit card account.
 While there are many other cyber threats 
out there, those listed above are among the most 
commonly encountered by users.  The traditional 
antivirus software will protect from some of the 
threats listed, but not all of them; this enhanced 
security capability is in the purview of the 
comprehensive security suite, or a combination 
of different types of individual security utilities, 
and not the free standing antivirus program.  this 
is explicitly why I currently recommend a high 
quality integrated security suite, rather than 
an antivirus program.  There are several good 
commercial security suites available, as well 
as a few free security suites.  Just be aware that 
antivirus software by itself is inadequate to protect 
against today’s contemporary cyber security 
threats. 

Defi ned - cont’d
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WEBSITES;
http://en.wikipedia.org/wiki/Malware
http://www.ilovefreesoftware.com/08/featured/
defi niton-of-various-security-related-terms.html
http://lifehacker.com/5560443/whats-the-
difference-between-viruses-trojans-worms-and-
other-malware
http://en.wikipedia.org/wiki/Computer_virus
http://en.wikipedia.org/wiki/Computer_worm
http://en.wikipedia.org/wiki/Trojan_horse_
(computing)
http://en.wikipedia.org/wiki/Rootkit
http://en.wikipedia.org/wiki/Backdoor_
(computing)
http://en.wikipedia.org/wiki/Rogue_antivirus
http://us.trendmicro.com/imperia/md/content/
us/trendwatch/researchandanalysis/12_
december_2010_threat_roundup__010711_.pdf

 In the past week, I was called upon four 
more times to clean malware off of infected 
computers. One user had a major name brand 
antivirus program installed, running, and updated 
and could not understand how the malware had 
penetrated his antivirus software and contaminated 
his computer.  He had purchased the antivirus 
software last fall from a big box electronics store 
based on the recommendations of a salesperson.  
He had been told that this particular brand of 
security software was the best as it was their top 
seller, and that antivirus software was all that he 
really needed.  Based on that recommendation he 
plopped his hard earned money on the counter, 
went home, installed it, updated it, and blissfully 
surfed the internet, opened email attachments, 
downloaded software and music, and had just a 
jolly good time online until his computer gradually 
slowed to a crawl, and friends informed him that 
they were receiving spam emails from him.  This 
user was perplexed, as his antivirus software was 
running, and indicated that it was updating several 
times a day.  He just could not understand how 

90 different malware programs had infected his 
computer.  His problem started when he purchased 
inadequate security software; while the product he 
bought was excellent at protecting his computer 
from viruses, and some Trojans and spyware, it 
did not offer the all-inclusive protection of the 
comprehensive security suite offered by that 
publisher (and others as well) that would have 
only cost him a few dollars more.
 There is a common misconception in user 
circles that viruses are the primary computing 
threat, as users have had heard about viruses for 
several years.  Today, viruses are present, but a 
relatively minor threat in terms of  prevalence.  
I did a quick analysis of the most common 
new threats recently listed by TrendMicro, and 
found that viruses only made up 4% of the new 
signifi cant threats to our computing security.  On 
the other end of the spectrum, Trojans made up 
42% of the commonly seen new threats, worms 
were at 14%, backdoors at 14%, web based threats 
were at 6%, java script malware was at 6%, 4% 
were hacking utilities, 2% adware, and about 8% 
other threats.  It is obvious that protective software 
that protects the computer primarily from viruses 
is failing to protect the user from the majority of 
contemporary threats; it is precisely this fact that 
led to this user’s infected computer, despite his 
premium quality antivirus software.  A lot of users 
have a misconception about the common threats 
in circulation, believing that they are generically 
all viruses, but, as I saw in this case, this blissful 
ignorance may lead to a computing nightmare.
 While not necessary to use a computer, it 
would likely be benefi cial for computer users to 
be aware of the different threat groups that can 
impact our computing.  According to Wikipedia, 
“A computer virus is a computer program that can 
copy itself and infect a computer.”  Many viruses 
attach themselves to legitimate programs or data 
fi les on the infected computer.  The fact that a 

Malware, Viruses, Trojans Defi ned
by 

Ira Wilsker

cont’d on Page 4
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cont’d on Page 2

computer virus can copy itself to infect other 
computers is what makes it different from other 
types of malware, for which viruses are commonly 
confused.  Viruses can be spread through digital 
media (USB drives, CD or DVD discs, and fl oppy 
discs) or through network connections that the 
virus can use to copy itself to other attached 
computers.  Once a virus has infected a computer 
it may perform a variety of tasks as programmed 
by its author.  Viruses may damage the data on 
a hard drive or degrade the performance of the 
computer.  Some of the viruses are stealthy and 
their effect may not be noticeable by the user, as 
the viruses do their damage in the background.  
Some viruses are functionally benign, other than 
they reproduce themselves countless times on the 
infected hard drive, until they consume all of the 
free space on the hard drive.
 Computer worms are a malicious computer 
program that wriggles through computer networks 
sending copies of itself to other computers 
attached to the network.  Most worms are 
free standing programs, and are commonly 
programmed to spread themselves through the 
network without any action by the user.  Most 
worms have an explicit nefarious function such 
as deleting fi les on the infected computer, or 
encrypting critical fi les, only releasing them 
after an extortion payment is made to the cyber 
criminal.  Some worms open a backdoor into 
the computer that will enable the creator of the 
worm to take remote control of the computer, 
converting the computer into a “zombie” under 
his control, which can be used to generate revenue 
for the originator of the worm by sending spam 
mail from the infected computer, with the spam 
fees collected going to the author of the worm.  
Some worms are used to create a zombie network 
of computers, also called a “botnet”, where the 
compromised computers can be used to launch 
directed cyber attacks on other computers or 
networks, in an act of cyber terrorism.

 For those who are aware of the epic 
“Helen of Troy” of Greek mythology, the term 
“Trojan Horse” means an object looks like it 
serves one purpose, but really has an unobvious, 
usually nefarious, purpose.  Cisco, the networking 
company, describes a Trojan as, “It is a harmful 
piece of software that looks legitimate. Users 
are typically tricked into loading and executing 
it on their systems”. In cyber speak, a Trojan 
Horse, typically shortened to the simple moniker 
“Trojan” is a program that appears to have a useful 
function, but after being installed by the user, the 
Trojan may be used to perform other undesirable 
functions.  Some Trojans are money makers for 
their authors because they place paid (and usually 
unwanted) pop up advertisements (Adware) on 
the infected computer, redirect web searches, 
or shift online purchases to a seller not of the 
buyer’s choice without his knowledge.  Some 
Trojans are keyloggers, which are commonly 
used for identity theft, or to give unauthorized 
users access to a computer system.  Trojans are 
often spread through intentionally downloaded 
software, surreptitiously bundled with another 
often legitimate program, from email attachments, 
and purloined websites with executable contact 
(ActiveX is sometimes used for this).  Some 
Trojans can be installed on the target computer by 
way of code written in Java, or a Java script, that 
when executed, implants the harmful content on 
the victim computer.
 One of the more recent and costly types 
of malware to attack our computers is generically 
referred to as “Rogue Antivirus Software”, which 
is usually implanted on the victim’s computer 
by a Trojan.  There are thousands of these 
rogue programs in current circulation, infecting 
millions of computers at any given time.  Rogue 
antivirus is sometimes installed by the user using 
“social engineering” tactics, which tricks the 
user into clicking on something that installs the 
rogue software.  Some of the common lures to 
ensnare the user into loading rogue software on 

Malware, Viruses, Trojans Defi ned - cont’d    cont’d from page 3
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Sneak Peek: A Quick Look at Windows 7 Service Pack 1 
Paul Thurrott
Supersite
InstantDoc ID #129443
Sometime soon, Microsoft will fi nalize its Service 
Pack 1 (SP1) release for Windows 7 and Windows 
Server 2008 R2. Today, however, a near-fi nal 
version of the service pack leaked online for both 
32-bit (x86) and 64-bit (x64) versions of the OSes, 
and I took the time to install the build on my main 
Windows 7 desktop. As I write this, I’m installing 
it on two laptops as well.

(A bit of rumor-busting. Some sites have claimed 
that SP1 is complete and that Microsoft will 
release it to its OEM--i.e. PC maker--partners as 
soon as tomorrow. That is not the case. SP1 is 
imminent, but it’s not quite done as I write this. It 
won’t be long.)

So what is going on here?

While Service Pack 1 services both Windows 
7 and Server 2008 R2, only the server side of 
things is getting a major upgrade with SP1. I’ll 
write about that later, and it will require a fair bit 
of explanation because of some major functional 
changes.

For Windows 7, the picture is quite a bit simpler: 
There are no major new features coming with 
SP1. However, there are the following minor 
changes:

An updated version of Remote Desktop Ser-
vices. This is required for a change that is coming 
in Server 2008 R2 with SP1 (RemoteFX).

Better support for third-party federation ser-
vices. With this update, Windows 7 now supports 
services that utilize the WS-Federation passive 
profi le protocol.

Improved HDMI audio device performance. 
SP1 fi xes a bug in Windows 7 where a small per-
centage of users experienced a disruption of audio 
over HDMI after a reboot.

Minor XPS document fi xes. For the rare case 
where an XPS document contains both portrait and 
landscape pages, SP1 fi xes a bug that prevented 
correctly-formatted printing.

Hot-fi xes and other bug fi xes. Like any service 
pack, SP1 also contains an aggregation of previ-
ously released and new hot-fi xes and other bug 
fi xes.

As you can see, nothing major.

While fi nal performance results will need to wait 
for the fi nal release and for more PCs to be tested, 
I can report that the interactive SP1 install took 
about 44 minutes on my quad-core Core 2 Duo-
based desktop. When Setup is complete and you’re 
returned to the Windows desktop, winver and the 
System window both report that SP1 is installed. 
Winver reports it’s at build 7601, where the fi nal, 
RTM version of Windows 7 was build 7600.

Looking ahead, I’ll of course report when SP1 
is offi cially released. I’m wondering whether a 
Slipstreaming guide is in order. And of course I’ll 
have a full review, for the Server side of the ser-
vice pack.

Screenshots

Windows 7 Service Pack 1 interactive Setup.

cont’d on Page 6
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Interactive Setup required ~40 minutes and one reboot.

Winver, post-install, indicates both SP1 and a new build number, 7601.

Windows 7 Service Pack 1 - cont’d
cont’d from page 5

System window, post-install, reports that Service Pack 1 is ap-

SOURCE:
http://www.techsupportalert.com/content/ultimate-
scientifi c-calculator-microsoft-and-its-free.htm
DIRECT DOWNLOAD:
http://www.microsoft.com/education/products/stu-
dent/math/default.aspx

 Microsoft used to sell a program called 
Mathematics, which was aimed at students.  It was a 
very capable product, able to solve equations, draw 
graphs, do calculus, and much more.  Ideal for any-
one involved with mathematics, science, engineer-
ing, physics, and so on.

 So why do I say “used to sell”?  Have they 
stopped producing it?  No.  They’ve merely stopped 
selling it, and are now giving it away!  There’s even 
a brand new version, 4,0, which was launched only 
last week.
 You can get it from http://www.microsoft.
com/education/products/student/math/default.aspx.  
It runs on all versions of Windows from XP onwards, 
and is available in both 32- and 64-bit fl avours.  
The installer itself is an 18 MB download, although 
you’ll also need .NET Framework 3.5 SP1, which is 
another 53 MB if you don’t already have it.
 If you’re a student, or you need to do math-
ematical calculations in your work, then check out 
Microsoft Mathematics.  And if you use Word or 
OneNote a lot, there’s even a version which works as 
an add-on in those programs too.

 

Microsoft Mathematics
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Do you keep track of information based on week-ending dates?  Many businesses do, and therefore 
need a quick way to calculate the week-ending dates for the complete year.  The dates could be easily 
calculated with a macro, but you can do it just as easily with formulas.

There are two formulas you can use in order to calculate your week-ending dates.  Let’s assume, for 
the sake of this example, that your year is stored in cell A1.  You could then fi gure out the fi rst Saturday of 
the year by using this formula in cell A3:

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1))

This works because the WEEKDAY function returns a value of 1 (Sunday) through 7 (Saturday) for 
any date.  If you subtract that value from 7, then you have a value of 6 (Sunday) through 0 (Saturday).  
When you add that value to the DATE value for January 1 of the year, you end up with the fi rst Saturday of 
the year.

If you prefer to have your weeks end on Fridays, then the formula needs to change a bit:
=DATE(A1,1,1)+7-(WEEKDAY(DATE(A1,1,1)+1))

Finally, if you prefer to have your weeks end on Sundays, then the formula needs to be like this one:
=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1),2)

This formula uses a parameter for the WEEKDAY function that calculates weekdays that range from 
1 (Monday) through 7 (Sunday).

Once you have the fi rst week-ending date for the year (in A3, remember?), then you can calculate the 
rest of the week-ending dates for the year.  Place the following formula in cell A4:

=IF(YEAR(A3+7)=$A$1,A3+7,””)

This checks to see if one week past the previous date is still in the year. If it is, then the new date is 
returned.  If it isn’t, then an empty string is returned.  If you copy this formula from A4 down through 
A55, then you will have all the desired week-ending dates for the year.  With the formulas in place, simply 
change the year in cell A1 to see how the dates change.

The range A3:A55 provides room for 53 week-ending dates, which is possible for any given year.  
Because you used the IF statement in the formula in cells A4:A55, then the very last value (A55) will be 
blank if there were only 52 week-ending dates for the year.

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found online 
at http://excel.tips.net.

Excel - Calculating Week-Ending Dates

More Excel and Word Tips More Excel and Word Tips from 

Word - Automatically Selecting Words
When you are editing your document, there are many times that Word tries to guess what you are 

doing and then complete your task for you.  This helpfulness can be aggravating at times. One such 
instance is when you are trying to use the mouse to select text from the middle of one word to the middle 
of another.  Whenever you click inside a word and then start dragging the mouse, Word assumes you 

cont’d on Page 8
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want to make a selection.  As soon as you move 
the mouse pointer outside the word, the program 
assumes you wanted to select the entire fi rst word 
in which you originally clicked.

If you want to ensure that Word doesn’t make 
that assumption, you need to follow these steps to 
turn off the offending feature in Word 97 through 
Word 2003:

1. Choose Options from the Tools menu. Word 
displays the Options dialog box.

2. Make sure the Edit tab is selected.

The Edit tab of the Options dialog box.

3. Make  su re  t he  When  Se l ec t ing , 
Automatically Select Entire Word check 
box is cleared.

4. Click on OK.

You can follow these steps if you are using 
Word 2007 or Word 2010:

1. Display the Word Options dialog box. 
(In Word 2007 click the Office button, 
then choose Word Options. In Word 2010 
display the File tab of the ribbon, then click 
Options.)

2. Click Advanced at the left side of the screen.

The Advanced area of the Word Options dialog box.

3. In the Editing Options area, make sure 
the When Selecting, Automatically Select 
Entire Word check box is cleared.

4. Click on OK.

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Word tips can be found 
online at http://word.tips.net.

cont’d from page  7
More Excel and Word Tips - cont’d
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 Smartphones can be seen all around.  
Notice the phone being used on your favorite 
TV show; next time, odds are that it’ll be a 
smartphone.  A year or two ago it was a fl ip phone 
(do you remember Jack Bauer on 24 using his?), 
but no more.  Now the phone of choice seems to 
be the smartphone.  Apple, and more recently, 
Google, have really changed the mobile phone 
landscape.  The iPhone, with its iOS Operating 
System available only on the iPhone, released in 
2009, really started the whole movement.  Google, 
with its Android Operating System (provided for 
free to hardware phone manufacturers), has come 
on very strong in the past few months so that 
iPhones and Android phones now have about the 
same market share - about 35% each, which only 
leaves 30% to be shared by Blackberry, Nokia, 
and Microsoft.
 The Smartphone equality, as stated in 
the title, suggests that the smartphone is equal, 
in functionality anyway, to a Personal Digital 
Assistant (PDA) and a standard mobile phone.  
PDAs have been a popular way of allowing one 
to have many of the computer fi les, pictures, 
videos and music, available on the go - remember 
the Palm Pilot.  A phone was another necessity 
for someone who was always on the go.  So for 
someone who had to be mobile and needed access 
their computer fi les, a phone and a PDA became 
a good combination.  I carried a PDA for many 
years and more recently, a PDA and a fl ip phone.  
Now I can carry only one device, a smartphone.  
And, as a welcome side effect, now I only have to 
make sure one device is charged nightly.
 The smartphone is made possible by 
a number of technologies.   Among them are: 
Capacitive touch-screens; 3G (soon to be 4G) 
wireless telephone networks; Wi-Fi; GPS; Micro-
miniature processors, memory and components; 
Digital Cameras; and Phone oriented Operating 
Systems.  Some of these technologies are used 

in phones - like touch screens, networks, small 
components, Digital cameras, and operating 
systems.  And some are used in PDAs - like touch 
screens, Wi-FI, small components, and operating 
systems.  As you can see there is a good bit 
of overlap, so putting it all together was just a 
natural.  But it took the genius of Apple to put it 
all together and make it work and make it practical 
and make it cool.  And now with the help of 
Google it has become more practical and popular.
 All of the technology for replacing the 
mobile phone and the PDA is included in the 
smartphone, and then some.  (I didn’t have a good 
camera in my mobile phone, before.)  But, it does 
take some planning and forethought to make the 
smartphone do everything.  Some of the things 
to be concerned with are: Contacts, (which are 
phone numbers, addresses, e-mail addresses, 
and related notes); Calendar events; E-mail; 
Memos, (which are lists of important things); 
Documents; Spreadsheets; Pictures, Videos, 
Music; and Browsers.  Before you can consider 
using any of these things there has to be an “App” 
(Application) installed on your smartphone.  (I 
am using a Motorola Droid2 as an example, but 
most of what I am referring to will be very similar 
on another Android smartphone, and even similar 
for an Apple iPhone.)  There are Apps for all of 
these tasks.  In fact there are over 100,000 Apps 
for Android phones and over 240,000 Apps for 
iPhones.
 So, the fi rst thing to do is to identify an 
App to handle each task you want accomplished.  
Your smartphone probably came with a basic 
collection of Apps.  Basic things like Contacts, 
Pictures, Videos, Music, and Camera will 
probably be covered by these Apps that were 
installed at the factory.  If not, you can go to the 
“Market” for Android Apps, or the Apple Store 
for iPhone Apps, and fi nd one that fi ts your needs.  

SmartPhone  =  PDA + Phone
by 

Phil Sorrentino

cont’d on Page 10
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Many of the Apps at these stores (websites) are 
free or have a nominal cost, most under $10.  
Things like Word or PDF Documents, or Excel 
spreadsheets may have to be handled by an App 
from one of these stores.  Once you get to the App 
store, you will fi nd a myriad of App titles.  You 
can typically search for “All Apps”, or limit your 
search to only free ones.  You can even search for 
Games that will run on your smartphone.  When 
you fi nd an App that you want, you will pay for it 
(via a credit card account that was previously set 
up) if it is not free, and then it will be downloaded 
right onto your smartphone.  The download is 
completely controlled from the Market and there 
is no further action on your part needed.  After the 
App is downloaded and installed, you will receive 
a message that it is complete.  It couldn’t be any 
easier.

 Once an App has been downloaded, it 
can be placed on the home screen.  Actually, one 
of the home screens.  The Droid2 has 7 home 
screens.  Multiple home screens make it easy for 
you to organize your Apps.  Apps that you think 
work together can be collected on a particular 
home screen.  You could have a home screen for 
entertainment, one for work, one for family, another 
for sports.  Any organization of Apps that makes 
sense to you would be appropriate.
 Once you’ve organized your home screens 
and downloaded the Apps needed, I’m sure you’ll 
see that the smartphone is a very useful device 
for someone on the go.  Future articles will 
concentrate on some of the new ways of interacting 
with the touch sensitive screen and some of the 
smartphone’s more interesting features, but I think 
you will now agree that: Smartphone = PDA + (not 
so smart) phone. :

SmartPhone - cont’d cont’d from page 9

SOURCE:
http://www.techsupportalert.com/content/my-free-
350-page-htmlcssphpmysql-book-get-it-while-you-
can.htm

DIRECT LINK:
http://www.the-web-book.com/

My Free 350-page HTML/
CSS/PHP/MySQL Book. Get 
It While You Can.
Updated 1. February 2011 - 20:43 by r.schifreen 
As you may know, I recently wrote a 350-page 
book, all about how to create web sites from scratch 
with HTML, CSS, JavaScript, PHP and MySQL.  
I’ve been giving it away for free at www.the-web-
book.com for the past year or so, where you can 
either browse it online or download a PDF fi le.  So 
far, around 58,000 people have grabbed the PDF.  If 
you’re one of them, thank you!

If you haven’t yet downloaded it, and you’re think-
ing about doing so, then allow me to give you a bit 
of insider information.  In around 1 month’s time, 
I’ll be changing things slightly.  You’ll still be able to 
browse the complete 350-page book online in your 
browser, but if you want to download the PDF fi le 
it’ll cost you a couple of dollars. 

So if you want the complete offl ine version for free, 
grab yours before it’s too late.

 

 

SmartPhone - cont’dSmartPhone - cont’dSmartPhone - cont’dSmartPhone - cont’dSmartPhone - cont’d

The Web Book for Free
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Minutes from the Board of Director’s Meeting – January 19, 2011

ATTENDEES: Mike Young, Mike Regimenti, Mike DeLucia, Fran Damrakowski
      Kathy Walker, Bill Somers, Kris Johnson, Craig Barlow, Sam Shephard

MEETING TOPICS:
February:  “System Components: Primary and Secondary Storage” presented by Joyce Shue and Mike 
Young

March:  “Streaming Video” presented by Mike Delucia

April:  “Backup Solutions” presented by Mike Young

May: TDB  

June:  (Takes place on June 1)  “System Components” 

SIGS:
Technology:  Mike Regimenti will present a review of G-Mail usage and Windows 7 upgrade.  No Tech 
SIG in June
CRSIG:  Fran reported that December was a slow month at the shop
MSCUG:  No report

FINANCES:
Bill reported that the club is in good fi nancial standing

NEW BUSINESS:
Polo shirts were presented to the board and shirts for the CRSIG were given to Fran for distribution

The new 8GB thumb drives have been ordered and will be in soon – They Have Arrived! Yeah!!!

Mike Young encouraged the board to look for potential candidates for board positions

Sam asked for help to conduct the Windows 7 Course.  Kris said that she would help with any 
administrative duties.  The new course is set to start on February 22 and run for 8 weeks.

Meeting was adjourned at 9:00 p.m.                    

Kris Johnson
Secretary
 

from the Secretary’s desk



The Next Regular Meeting will be at
The Severn River Middle School

Wednesday
February 9th, 2011

Meeting will be held in the large meeting room.
It starts at 7:00 P.M. with club business

and a short discussion period.

presentation on

Hard Drives
by

Joyce Shue 
& 

Mike Young
Members and their friends are welcome to 

come, ask questions and become enlightened.

How to Find: Severn River Middle School

 SRMS is close to the Arnold, MD campus of the 
Anne Arundel Community College.  From Annapolis 
and points south, take Rte 2 (Ritchie Highway) north 
about 3 miles from the intersection of Rt. 50, turn right 
on College Parkway.  At the fi rst light, turn left on 
Peninsula Farm Road.  (Of course, if you are coming 
from points North, you would turn left onto College 
Parkway)  about a half-mile down the road the large 
SRMS school building, set back off a large two level 
parking lot, will be visible on your right.  Park here 
and go to the main entrance.  Signs will be posted to 
direct you to the Large Group Room where we will 
be meeting.

How to fi nd: The Technology SIG, A ChPCUG 
Special Interest Group**

The meetings are held at the SRMS in the Library.

               

 
Note: The date above your name on the mailing label is the 
expiration date of your membership.  Contact the Member-
ship Chairman (page 2, column 2) to update.

   FIRST CLASS

 INSIDE THIS VERY ISSUE!

 

            1783 Forest Drive #285
             Annapolis, MD 21401

Proudly Affi liated with

President’s Corner
Malware, Viruses & Trojan Horses
SmartPhone
Microsoft Mathematics
Windows 7 SP1
 ... and a little bit more!


